LENESANS Release Note

RZ/T2H Group
Encoder I/F FA-CODER sample program

Summary
This document describes the RZ/T2H Encoder I/F FA-CODER® sample program package.

For FA-CODER® communication protocol specifications and encoder specifications, contact Tamagawa Seiki
Co,, Ltd.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)
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RZ/T2H Group Encoder I/F FA-CODER sample program

1. Package Contents

This package contains the following contents.
The RZ/T2H FA-CODER interface supports up to 12 axes, but the sample program supports only 1 axis of
them. If you use with 2 axes or more simultaneously, modify the sample program to support required axes.

1.1 Software
e Source code

No. Name Version number
1 RZ/T2H FA-CODER sample program (CR52 ver. *) 4.0
2 RZ/T2H FA-CODER sample program (CA55 ver. *) 4.0

Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Documents

No. Document name Version File name
1 RZ/T2H Group Encoder I/F FA- 4.00 (j) r11an0784j0400-rzt2h.pdf
CODER Sample Program Release (e) r11an0784ej0400-rzt2h.pdf (this document)
Note
2 RZ/T2H Group FA-CODER Sample 4.00 (j) r11an0783j0400-rzt2h-fa-coder.pdf
Program Application Note (e) r11an0783ej0400-rzt2h-fa-coder.pdf
R11AN0784EJ0400 Rev.4.00 Page 2 of 15



RZ/T2H Group Encoder I/F FA-CODER sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
— r11an0784jj0400-rzt2h.pdf
F— r11an0784ej0400-rzt2h.pdf
L— workspace

— Software

| — iccarm

| | — RZ_T2H_CR52_fac.zip : RZ/T2H FA-CODER sample program set
I CR52 ver. (IAR)

| | L— RZ_T2H_CA55 fac.zip : RZ/T2H FA-CODER sample program set
| | CA55 ver. (IAR)

| —gcc

| F— RZ_T2H_CR52_fac.zip : RZ/T2H FA-CODER sample program set
| | CR52 ver. (e2 studio)

| L— RZ_T2H_CA55_ fac.zip : RZ/T2H FA-CODER sample program set
|

CAS5S5 ver. (e? studio)
L— Documents

— r11an0783jj0400-rzt2h-fa-coder.pdf

L— r11an0783ej0400-rzt2h-fa-coder.pdf

The file structure of the RZ_T2H_CR52_fac.zip and RZ_T2H_CA55 fac.zip are shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Environment File Depending on Build Tool )
L— src
— hal_entry.c : FA-CODER sample program
— fac_main.c : FA-CODER sample program
— siochar.c : SCI_UART sample program
— syscalls.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— fac
— iodefine_fac.h : FAC register definition file
F— r_fac_rzt2.c : FAC driver file
— r_fac_rzt2_config.h : FAC driver file
F— r_fac_rzt2_dat.h : FAC driver file
F— r_fac_rzt2_if.h : FAC driver file
F— r_scie.c : FAC driver file
L— r_scie.h : FAC driver file
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RZ/T2H Group Encoder I/F FA-CODER sample program
3. About FA-CODER Sample Program

This section contains information necessary to use the complete set of FA-CODER sample programs.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and FA-CODER driver is shown in following table. This table does
not include memory size used by Flexible Software Package or C language libraries of the compiler, but for
the DMAC driver portion which is used for the FA-CODER encoder interface.

(1) CR52 ver.

ltems Memory Size
EWARM e? studio
[kBytes] [kBytes]
FA-CODER driver Code 7.7 7.0
Data (with initial value) 0.0 0.0
Data (without initial value) 2.7 2.7
Constant Data 0.7 0.7
DMAC driver for encoder interface* | Code 2.8 2.0
Data (with initial value) 0.0 0.0
Data (without initial value) 0.2 0.2
Constant Data 0.0 0.0
Sample program Code 4.3 4.9
Data (with initial value) 0.0 0.0
Data (without initial value) 0.5 0.5
Constant Data 2.2 2.2

Note: The DMAC driver are used for the FA-CODER encoder interface. They are called from inside of the FA-
CODER driver.
The function using DMAC driver is enabled only in the CR52 version.

(2) CAS55 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
FA-CODER driver Code 11.9 10.1
Data (with initial value) 0.0 0.0
Data (without initial value) 3.3 3.4
Constant Data 1.1 1.4
Sample program Code 6.9 8.8
Data (with initial value) 0.1 0.0
Data (without initial value) 0.5 0.6
Constant Data 24 3.0
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RZ/T2H Group

Encoder I/F FA-CODER sample program

3.2 Hardware Information
3.21
RZ/T2H

Device

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)

(2) Setting of Target Board
The target board configuration is as follows.
SW1-6: OFF
SW2-1: ON, SW2-2: OFF
SW2-7: OFF
SW2-8: OFF

SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set to xSPI1 boot mode)
CN39: Short between 2-3 pins (Set VDD1833 210 3.3 V)
CN40: Short between 2-3 pins (Set VDD1833_3 to 3.3 V)

CN78: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3 V)

(3) Used Pins of the Target Board

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows.
Channel Pin Name | Pin Header | Input/Output Voltage Description
Domain
FACODERO RXDEOO CN2 #9 input VDD33 Data reception pin
TXDEOO CN2 #7 output VDD33 Request output pin
DEEOO CN2 #5 output VDD33 Drive/receive control pin
FACODER1 RXDEO1 CN2 #8 input VDD1833_3 | Data reception pin
TXDEO1 CN2 #6 output VDD1833_3 | Request output pin
DEEO1 CN2 #4 output VDD1833_3 | Drive/receive control pin
FACODER2 RXDEO02 CN2 #17 input VDD33 Data reception pin
TXDEO2 CN2 #15 output VDD33 Request output pin
DEEO02 CN2 #13 output VDD33 Drive/receive control pin
FACODERS3 RXDEO03 CN2 #18 input VDD33 Data reception pin
TXDEO3 CN2 #16 output VDD33 Request output pin
DEEO3 CN2 #14 output VDD33 Drive/receive control pin
FACODER4 RXDE0O4 CN2 #27 input VDD1833_5 | Data reception pin
TXDEO4 CN2 #25 output VDD1833 5 | Request output pin
DEEO4 CN2 #23 output VDD33 Drive/receive control pin
FACODER5 RXDEO5 CN2 #26 input VDD1833_6 | Data reception pin
TXDEO5 CN2 #24 output VDD1833_6 | Request output pin
DEEO5 CN2 #22 output VDD1833 6 | Drive/receive control pin
FACODERG6 RXDE06 CN3 #9 input VDD1833_3 | Data reception pin
TXDEO6 CN3 #7 output VDD1833_3 | Request output pin
DEEO6 CN3 #5 output VDD1833_3 | Drive/receive control pin

R11ANO784EJ0400 Rev.4.00
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RZ/T2H Group

Encoder I/F FA-CODER sample program

Channel Pin Name | Pin Header | Input/Output Voltage Description
Domain
FACODER7 RXDEOQ7 CN3 #8 input VDD1833_3 | Data reception pin
TXDEQ7 CN3 #6 output VDD1833_3 | Request output pin
DEEO7 CN3 #4 output VDD1833_3 | Drive/receive control pin
FACODERS RXDE08 CN3 #17 input VDD33 Data reception pin
TXDEOS8 CN3 #15 output VDD33 Request output pin
DEEOS8 CN3 #13 output VDD33 Drive/receive control pin
FACODER9 RXDE09 CN3 #18 input VDD1833_2 | Data reception pin
TXDEQ9 CN3 #16 output VDD1833 2 | Request output pin
DEEO9 CN3 #14 output VDD1833 2 | Drive/receive control pin
FACODER10 RXDE10 CN3 #27 input VDD1833_2 | Data reception pin
TXDE10 CN3 #25 output VDD1833_2 | Request output pin
DEE10 CN3 #23 output VDD1833 2 | Drive/receive control pin
FACODER11 RXDE11 CN3 #26 input VDD1833 2 | Data reception pin
TXDE11 CN3 #24 output VDD1833_2 | Request output pin
DEE11 CN3 #22 output VDD1833_2 | Drive/receive control pin
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RZ/T2H Group

Encoder I/F FA-CODER sample program

3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H_N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-12
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_ CR52_fac.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_T2H_fac.eww.

Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b~ wWwN

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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RZ/T2H Group Encoder I/F FA-CODER sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rz,
rz_cfg, rz_gen, script and .setting folders will be generated.

G C:\1_Prog\Work\Work_C\Work_EWA_960.3_fsp4.0.0\RZT2H_FAC release_chk - FSP Smart Configurator - [} X
File Window Run Help
&% [RZT2H_FAC_release_chk] FSP Configuration X % FSP =0
»
Summary Generate Project Content 5
Project Summary Renesas
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: R9A09GO77M44GBG
Core: CR52 CPUO
FSP Version: 4.0.0
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_960.3_fsp4.0.0/RZT2H_FAC_release_chk x|
Selected software components
Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZT2H Evaluation Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0 v
@ Stbpoit u
Summary | BSP| Clocks| Pins| Interrupts| Event Links | Linker Sections | Stacks| Components > Al
[ Properties [2! Problems M8 =8 B consle ~fy=08
No consoles to display at this time.
Properties are not available.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild All] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_fac.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2H Group FA-CODER Sample Program Application Note.

| M| COM9 - Tera Term VT = m] X
TPAUF)  |EE)  RES) IVMO-LO) PAYEIW)  ALTH)

Tama sample program start
R_FAC_GetVersion = 4.0

tamagawa>single
single command
result:success

single turn data: 8388607
request id: OH
parity bit(request id):
information code:
encoder alarm:

R11AN0784EJ0400 Rev.4.00 Page 8 of 15
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RZ/T2H Group Encoder I/F FA-CODER sample program

3.3.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2025-12
Toolchain version: GNU Arm Embedded 13.3.1.arm-13-24
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.60

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CR52_fac.zip and copy the extracted source files to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu ->[Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

) RZT2H_FAC_release_chk - € studio — [m] X
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas 365 Window Help
| ® -~ 5& vi@ LR R 0 4 Q & Not Connected @‘ Bgic/CH+
Project Explorer % =8 = B8  outine X =8
R Y 3 . : n
= S U s There is no active editor that
v 155 RZ_T2H _fac [Debug] provides an outline.

> |l Includes

> (2) Developer Assistance

Problems X Console Properties Smart Browser Smart Manual y § =8
0 errors, 11 warnings, 0 others
Description : Resource Path Location Ty
> & Warnings (11 items)
& configurationxml - RZ_T2H_fac
R11ANO784EJ0400 Rev.4.00 Page 9 of 15



RZ/T2H Group Encoder I/F FA-CODER sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rz, rz_cfg, rz_gen, script and .settings folders are generated.

8) RZT2H_FAC_release_chk - RZ_T2H_fac/configuration.xml - e? studio - (u] X
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas 365 Window Help
&~ wits v Qv Q&) Not Connected : B | @ C/C++
Project Explorer X = O & RZ_T2H_fac] FSP Configuration X ™ Outline X SELD als]
BSY 8| summary o There is no active editor that provides an
25 RZ_T2H fac Generate Project Content il outline.
@ Includes
7cY Project Summal
2 src ) Yy RENESAS
¢ configuration.xm|
RZ_T2H _fac Debugjlink Board: RZT2H Evaluation Board (RAM execution without flash memory)
¥ RZ_T2H fac Debug.launch Device: R9YA09G077M44GBG
Core: CR52 CPUO
2) Developer Assistance X
Toolchain: GCC for Renesas RZ
Toolchain Version: 44 54 o0 43 54
FSP Version: 4.00
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_E2S_RZ../RZT2H_FAC_release_chk/RZ_T2H_fac <]
Selected software components
Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZT2H Evaluation Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0 i
Summary | BSP| Clocks | Pins| Interrupts| Event Links| Linker Sections | Stacks| Components
Problems X  Console Properties Smart Browser Smart Manual =8
0 errors, 11 warnings, 0 others
Description Resource path Location Type

4 Warnings (11 items)

7 Select [Project] menu -> [Build All].
The file Debug\RZ_T2H_fac.elf is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2H Group FA-CODER Sample Program Application Note.

| M COMS9 - Tera Term VT - [w] X
T7AIWF)  $REE) REES) IVRO-L(O) 2¥EIW)  ALTFH)

Tama sample program start
R_FAC_GetVersion = 4.0

tamagawa>single
single command
result:success

single turn data: 8388607
request id: OH
parity bit(request id):
information code:
encoder alarm:
communication alarm:

crc data:
‘tamagawa>
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RZ/T2H Group

Encoder I/F FA-CODER sample program

3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Sending / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for Arm (EWARM)

Version 9.60.3 + patch (EWARM_Patch_for RZT2H N2H_ rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-12
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_ CA55_ fac.zip and copy the extracted source files to the desired location.
Activate EWARM.

Select [File] menu -> [Open Workspace].

Open the extracted source file RZ_T2H_CA55_0_fac.eww.

Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

a b~ wWN

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11ANO784EJ0400 Rev.4.00
Mar 27.26
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RZ/T2H Group Encoder I/F FA-CODER sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rz,
rz_cfg, rz_gen, script and .setting folders will be generated.

!E C\1_Prog\Work\Work_C\Work_EWA_960.3_fsp4.0.0\RZT2H_FAC_CA55_release_chk - FSP Smart Configurator

File Window Run Help ‘

4 [RZT2H_FAC_CASS_release_chk] FSP Configuration X enizleny %7 FSP Visuali =8

Summary 0 =1

Generate Project Content

Project Summary Renesas
Board: RZT2H Evaluation Board (RAM execution without flash memory)

Device: R9A09GO77TM44GBG

Core: CA55 Core0

FSP Version:  4.0.0

Project Type: Flat

Location: C:/1_Prog/Work/Work_C/Work_EWA_96...p4.0.0/RZT2H_FAC_CA55_release_chk x|

Selected software components
Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0

RZT2H Evaluation Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0 ~

»EO

Summary | BSP| Clocks | Pins | Interrupts | Event Links| Linker Sections | Stacks Components > AB

[ Properties [2 Problems ™ $% =8 B console =8
No consoles to display at this time.

Properties are not available.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_T2H_CA55_0_fac.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2H Group FA-CODER Sample Program Application Note.

| M COM9 - Tera Term VT - m} X

TPAIAF) REE) BES) IVFO-LO)  HYEIW)
Tama sample program start
R_FAC_GetVersion = 4.0

AT (H)

tamagawa>single
single command
result:success

single turn data: 8388607
request id: OH
parity bit(request id):
information code:
encoder alarm:
communication alarm:

crc data:
tamagawa>
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RZ/T2H Group Encoder I/F FA-CODER sample program

3.4.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2025-12
Toolchain version: GCC Arm A-Profile (AArch64 bare-metal) 13.2.1.20231009
RENESAS Flexible Software Package (FSP) for RZ v4.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.60

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_ CA55_ fac.zip and copy the extracted source files to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu ->[Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml the Project Explorer pane of e2 studio to open it.

{8 RZT2H_FAC_CAS5 release_chk - * studio = m] X
File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas 365 Window Help

| -4 -0 ity @~ Q&) Not Connected %)‘ EEc/c++
Project Explorer X E % Y § = O = 8  outline X =8
v I RZ_T2H _CAS5 0 fac [Debug] There s no active editor that

> [l Includes provides an outline,
pc)

5 configuration.xml|

5 RS-0 Tac Debug jlink

X| RZ_T2H_CA55_0_fac Debug.launch

> (2) Develo per Assistance

=

Problems X Console Properties Smart Browser Smart Manual § =08

0 errors, 11 warnings, 0 others

Description Resource Path Location Type

> & Warnings (11 items)

5 configuration.xm! - RZ_T2H_CAS5 0 fac
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RZ/T2H Group Encoder I/F FA-CODER sample program

6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rz, rz_cfg, rz_gen, script, .settings folders are generated.

{8 RZT2H_FAC_CASS release_chk - RZ_T2H_CAS5._0_fac/configurationml - e studio = [u] X

| File Edit Source Refactor Navigate Search Project RenesasViews Run Renesas365 Window Help
N |
Q&) Not Connected : B | Egic/c++

W % - ity v Qv
¢ = = !
Project Explorer X =1 G H o [RZ_T2H_CAS5_0 fac] FSP Configuration X Outline X SESD W=
[ RZ_T2H_CA55 0 fac Summary There is no active editor that
&) Includes Generate Project Content  § 5ovides an outline.
@ src
3¢ configuration.xml Project Summary Renesas
RZ_T2H_CA55_0_fac Debug jlink ) )
%) RZ_T2H_CAS5_0_fac Debug.launch Boa‘rd. RZT2H Evaluation Board (RAM execution without flash memory)
o Device: RIA09G077M44GBG
?) Developer Assistance
Core: CA55 Core0
Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
Toolchain Version: 13.2.1.20231009
FSP Version: 4.00
Project Type: Flat
Location: C:/11_Prog/Work/Work_C/Work_E2S_RZ...A55_release_chk/RZ_T2H_CA55_0_fac = |
Selected software components
Arm CMSIS Version 6 - Core v6.1.0+fsp.4.0.0
RZT2H Evaluation Board Support Files (RAM execution without flash memory) v4.0.0
Memory Config Checking v4.0.0
Board support package for RZT2H v4.0.0 ~
g support U
Summary | BSP| Clocks| Pins  Interrupts| Event Links | Linker Sections | Stacks| Components.
Problems X Console Properties Smart Browser Smart Manual g = O |
0 errors, 11 warnings, 0 others
- Resource Path Location Type |

Description
& Warnings (11 items)

7 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_CA55_0_fac.elf file is generated.

(4) Execution Procedure of the Sample Program
After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.
1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].

2  Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2H Group FA-CODER Sample Program Application Note.

| M COM9 - Tera Term VT
271 BEE) FEES) IvO-L(O)

Tama sample program start
R_FAC_GetVersion = 4.0

AT (H)

94 RIW)

‘tamagawa>single
single command
result:success

single turn data: 8388607
request id: OH
parity bit(request id): OH
information code: OH
encoder alarm:
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RZ/T2H Group Encoder I/F FA-CODER sample program

Revision History

Description
Rev. Date Page Summary
0.50 Sep.08.23 - First Edition issued
0.60 Mar.01.24 2,3 Update the application note and release note version number.

Update sample program version to 0.6. (It supports elctimer
command emulating ELC by using CPU and DMA. Corrects
response without connecting encoder to return error information.
Revises to set cpsr register automatically on launching debugger
of e? studio.)

3 Update file structure. (Add dmac folder.)
4 Update memory size information.
1,5 Update board name description.
8,10 Revise e? studio sample execution procedure by automatic cpsr
set. Figures of console are updated.
0.70 Apr 05.24 2-4 Update the application note and release note version number.

Update sample program version to 0.7 (Support FSP v1.3.0)
Update file structure. Add structure of CA55 version.

5 Update memory size information. Add information of CA55 ver.
8-11 Update build environment and figures for CR52 ver.
12-16 Add development procedures for CA55 ver.
2.00 Nov 21.24 2-4 Updated revisions of the application note and the release note.

Update sample program version to 2.0 (Supported FSP v2.2.0)
Update the file structure.

5 Update memory size information.

6 Added xSPI1 boot mode to target board settings.
8-17 Updated build environment to FSP v2.2.0 and replaced figures.

2.01 Dec 13.24 2,3 Update revision of the release note.
Correct path name of the FSP SC in the sample program
environment files to use default installation path.

3.00 Aug 29.25 2,3 Updated revisions of the application note and the release note.
Updated sample program version to 3.0. (Supported FSP v3.0.0.)
Updated the file structure.

4 Updated memory size information.
7-14 Updated build environment for FSP v3.0.0. Figures are replaced.

3.10 Nov 7.25 2,3 Update revision of the release note.
Updated sample program version to 3.1. (Use FIFO for
communication buffer.)

4 Update memory size information.
7-14 Update build environment and replace figures.
4.00 Mar 27.26 2,3 Updated revisions of the application note and the release note.

Updated sample program version to 4.0. (Supported FSP v4.0.0.)
Updated the file structure.

4 Updated memory size information.
7-14 Updated build environment for FSP v4.0.0. Figures are replaced.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

- FA-CODER is a registered trademark of Tamagawa Seiki Co., Ltd.

- IAR Embedded Workbench is a registered trademark of IAR Systems.

- J-Link is a trademark of SEGGER Microcontroller GmbH.

- Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.
All rights reserved.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2026 Renesas Electronics Corporation. All rights reserved.
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